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1. Welcome to COPA-DATA help

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com
(mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact
via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com (mailto:sales@copadata.com).

2. Tools

A range of tools support you for the management, analysis and configuration of zenon:
» Diagnosis Viewer (on page 6): Allows zenon LOG files to be read and configured.

» Keyblock Runtime Start (on page 48): Starts zenon Runtime and at the same time blocks all
Windows system keys.

» Online updating of the zenon Help (on page 50): Allows online updating of zenon Help.

» Project Translation Interface: Tool for the translation of zenon language files. Opens or saves
data for the zenon Language Translation Wizard. With this, projects can be imported into or
exported out of zenon.
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» Startup Tool (on page 61): Makes it possible to start the Editor and Runtime with certain
parameters, to administer different zenon versions on one computer, to administer SQL
instances and to define languages for Editor and Runtime.

» System Information Collector (on page 92): Reads system information and zenon information,
displays it in an output window and saves it as a ZIP file.

The following are available for zenon Logic:

» zenon Logic Runtime Manager: Administer all stand-alone/manual-start zenon Logic Runtime
projects on your computer.
The documentation for this tool is part of the zenon Logic documentation.

3. Diagnosis Viewer

All zenon modules such as Editor, Runtime, drivers, etc. as well as zenon Analyzer write messages to a
joint log file. These can be read and configured with the Diagnosis Viewer program. The Diagnosis
Viewer allows the reading of existing log files, online logging, saving of the current view, setting
parameters for the Diagnosis Clients and the Diagnosis Server.

3 License information

Part of the standard license of the Editor and Runtime.

STARTING THE DIAGNOSIS VIEWER
The piagnosis Viewer Will be installed in the folder: $Program Files (x86) %\Common
Files\COPA-DATA\STARTUP. Callit up under:

» Windows 8: Enter "Diagnosis viewer" on the desktop for apps

» Windows 7: Start/All Programs/zenon/Version Independent Tools -> Diagnosis Viewer.

The Diagnosis Viewer is only available in English.

USING IPV6

The Diagnosis Server also works with Diagnosis Clients which addresses via IPv6 addresses. For this the
format of the log file has been adapted. The Diagnosis Viewer only reads the new format of the log files.
If files from older zenon versions are opened (or vice versa), the IP address of the Diagnosis Client is not
displayed correctly.



DRIVER ANALYSIS

zenon driver log all errors in the log files. The default folder for the log files is subfolder Log in directory
ProgramData, example:

C:\ProgramData\COPA-DATA\LOG. Log files are text files with a special structure.

Attention: With the default settings, a driver only logs error information. With the Diagnosis Viewer
you can enhance the diagnosis level for most of the drivers to "Debug" and "Deep Debug". With this the
driver also logs all other important tasks and events.

In the Diagnosis Viewer you can also:

>

3.1

follow currently created entries live
customize the logging settings

change the folder in which the log files are saved

In Windows CE even errors are not logged per default due to performance reasons.
The Diagnosis Viewer displays all entries in UTC (coordinated world time) and not in local time.

The Diagnosis Viewer does not display all columns of a log file per default. To display more
columns activate property Add all columns with entry in the context menu of the column
header.

If you only use Error logging, the problem description is in column Error text. For other
diagnosis level the description is in column General text.

For communication problems many drivers also log error numbers which the PLC assigns to
them. They are displayed in Exrror text and/or Error code and/or Driver error parameter (1
and 2). Hints on the meaning of error codes can be found in the driver documentation and the
protocol/PLC description.

At the end of your test set back the diagnosis level from Debug or Deep Debug. At Debug and Deep
Debug there are a great deal of data for logging which are saved to the hard drive and which can
influence your system performance. They are still logged even after you close the piagnosis

Viewer.

General

The zenon Diagnosis System logs error messages from zenon and zenon Analyzer. It consists of three

parts:
>
>

>

Diagnosis Server (on page 21): local or or defined in zenoné6.ini defined zenLogsrv
Diagnosis Clients (on page 25): all modules, drivers, services, etc. which write messages

Diagnosis Viewer (on page 27): Analysis program



VERSIONS
From version zenon 7.00 on the service zenLogsrv is used instead of the zensyssrv for the diagnosis
system. That means:

» Diagnosis systems up to version 6.51 and from version 7.00 are each compatible among
themselves.

» The diagnosis mechanism of zenon 6.51 SPO and zenon 7.00 SPO are not compatible.

Compatibility Diagnosis Server 6.51 SP0 Diagnosis Server 7.00 SPO
and earlier and higher

Diagnosis Client 6.51 SP0O and earlier compatible incompatible

Diagnosis Viewer 6.51 SPO and earlier compatible incompatible

Diagnosis Client 7.00 SPO and higher incompatible compatible

Diagnosis Viewer 7.00 SPO and higher incompatible compatible

With the Diagnosis Viewer version 7.00 SPO and higher you can open log files which were created by
Diagnosis Server version 6.51 SPO (or earlier). It does not work the other way round.
DEFAULT PORTS

» Version 7 and higher: 50780 (port of service zenLogSrv)
» upto6.51: 1101 (port of service zenSysSrv)

If the port cannot be opened, the service closes itself.

& Attention

If the port to which the Diagnosis Viewer should connect is closes, then it is tried to start
the local Diagnosis Server. This makes sure that local logging is carried out if no
Diagnosis Server is available in the network.

MEMORY OCCUPANCY

Service zenLogsrv buffers log entries until they can be written in the log file. If the memory
consumptions increases continuously by zenLogsrv, it is an indicator that the log file cannot be written.

3.2 Topology of the diagnosis system

The topology of the diagnosis system differs for versions up to 6.51 SPO and from 7.00 SPO on.



TOPOLOGY BEFORE ZENON 7.00 SPO

The diagram displays all possible connections for which zensyssrv is responsible. Each arrow represents
a network connection between the applications. All applications connect to the zenSyssrv on port 1101

regardless of whether Client and Server are on the same computer or communicate with each other via
a network.

N/

1. The Editor sends log entries, commands and data of the Remote Transport to zensSyssrv.
zenSysSrv sends the configuration of the Diagnosis Clients (Editor, Runtime, driver, Web Server,
Web Client, etc.) and the Remote Transport data to the Editor.

2. The Diagnosis Viewer sends diagnosis commands, diagnosis configurations and log entries to
zenSysSrv. zenSysSrv sends diagnosis data and the Diagnosis Client configuration to the
Diagnosis Viewer.

3. zenSysSrv sends the Diagnosis Client configuration to the Diagnosis Clients. The Diagnosis
Clients send log entries to zenSysSrv.

zenSysSrv reacts correspondingly to each incoming message:
» Log entries are written in log files.
» Remote Transport commands (start Runtime, write/read back data, etc.) are executed.

» Diagnosis commands (set Server/Client configuration, start online logging, etc.) are executed.



TOPOLOGY AS OF ZENON 7.00 SPO

The diagram displays all possible connections for which zensyssrv and zenLogsrv (as of version 7.00
SPO0) are responsible. Each arrow represents a network connection between the applications. All
applications connect to zenLogsrv on port 50780. The editor connects to zenSysSrv on port 1101. It is
regardless of whether Client and Server are on the same computer or communicate with each other via
a network.

/ |
/

1. The Editor sends commands and data of the Remote Transport to zenSysSrv. zenSysSrv sends
data of the Remote Transport to the Editor.

2. The Editors send log entries to zenLogSrv. zenLogSrv sends the Diagnosis Client configuration
to the Editor.

3. The Diagnosis Viewer sends diagnosis commands, diagnosis configurations and log entries to
zenSysSrv. zenSysSrv sends diagnosis data and the Diagnosis Client configuration to the
Diagnosis Viewer.

4. The zenSysSrv sends log entries to the zenLogSrv. zenLogSrv sends the Diagnosis Client
configuration to zenSyssSrv.

5. zenLogSrv sends the Diagnosis Client configuration to the Diagnosis Clients. The Diagnosis
Clients send log entries to zenLogSrv.

zenSysSrv reacts to: incoming Remote Transport commands.
zenLogSrv reacts to incoming diagnosis commands and log entries

EXAMPLE

IN an environment with a central Diagnosis Server the Runtime is started on a device. Based on the
Runtime version the configuration is read from zenoné.ini. Versions before 7.00 SPO read entry
LOG_CONFIG from [sYs_REMOTE], later versions read this entry from [LOGGING sysTEM]. This
configuration is used to establish a diagnosis connection. (For details see Standard procedure (on page
11).) Each additional component loaded by the Runtime (driver, zenNetsrv, etc.) also establish a
diagnosis connection.
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3.3 Standard procedure

As default only error messages (errors) are sent from the Clients to the Diagnosis Server.

The Diagnosis Server saves the received messages in TXT files with a special structure (on page 44). The
default folder for the log files is subfolder Log in folderProgrambData. For example:
$ProgramData%$\COPA-DATA \LOG.

For more information see manual Installation and Updates chapter File structure.

Note: Under Windows CE error messages are also not created per default due to resource issues.

In order to report not only error messages to the Diagnosis Server but also other information important
for the diagnosis, the according settings have to be defined for the Client (on page 25).

You can also configure the behavior of the Server (on page 21).

CONFIGURATION

The configuration of the connection is done in zenon6.inl (on page 12) divided in:
» Diagnosis Clients
» Diagnosis Server

» Versions to make sure that the configuration of the versions does not affect each other

The configuration of the Diagnosis Viewer (on page 27) also enables you to configure settings for the
connection:

» Settings of the server (on page 22)
» Connection settings Diagnosis Server connection (on page 30)
» Diagnosis Client (on page 25)

» Diagnosis Viewer - Analysis Program (on page 27)

We recommend to do the configuration of the connection for Server and Client via zenon6.ini.

PROCEDURE

The Diagnosis Server is:

» aservice at the PC.
The service starts automatically when the operating system boots. The local service can only be
started once.

» anapplication under CE.
Under CE only one process can use the port. Additionally started processes terminate
themselves as the port cannot be opened. If the local configuration of the Diagnosis Server is set
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under CE in such a way that only the user interface is displayed (INIT=2), several processes could
emerge by the Diagnosis Clients trying to start the local Diagnosis Server.

As soon as a Diagnosis Client gets active, the following steps are carried out:

1. The Diagnosis Client reads and uses the configuration from zenoné6. ini. If no configuration is
available in zenon6. ini, the default configuration (Diagnose Server=localhost:50780)is
used.

2. The Diagnosis Client tries to establish a connection to the Diagnosis Server:

Establishing successful:

a) The diagnosis connection has been established and the log entries are sent.

Establishing failed:

b) The Diagnosis Client tries to start and use the local Diagnosis Server.
On a PC it tries to start the service.
Under CE it tries to create the process.

c) The Diagnosis Client tries to establish a connection to the local Diagnosis Server. If it
succeeds, the diagnosis connection is established and the log entries are sent.

If it fails, no log entries are created.

3.3.1 Entries in zenonb.ini

The configuration of zenSysSrv and zenLogSrv is carried out via zenon6.ini. At this it is differentiated
between version 7.00 and up and versions 6.51 and earlier. With this you can configure old and new
Diagnosis Clients and Diagnosis Servers independent of each other on one device. For example, the LOG
entries of old Diagnosis Clients are diverted, without the LOG entries of new clients being affected.

12



DIAGNOSIS SERVER BEFORE VERSION 7.00 SPO

INI entry

[SYS_REMOTE]

LOGDirectory=

CONFIG=

LOGMinFreeDiskSpace=

LOGMaxUsedDiskSpace=

LOGMinUsedDiskSpace=

Description

Section in zenoné6.ini.

Contains parameters for zenSysSrv (Remote Transport and Diagnosis Server).
Defines folder for the LOG files.

If there is no entry, the LOG folder in the %ProgramData% folder is used as a
default value.

Example:
LOGDirectory= $ProgramData%\COPA-DATA\ zenon651\LOG

Configuration string for the Diagnosis Server and zenSysSrv. Remote
Transport and the diagnosis system use the same server configuration up to
and including version 6.51 SPO. The string consists of the following parts:
DEVICE=[Device] ; HOST=[Hostname] ; PORT=[Port]; TIMEOUT=|
Timeout]

» DEVICE: Sets the communication type used.
TCP/IPand serial are available.

» HOST: Is set to the computer name of the Diagnosis Server.
» PORT: states the port to be used.

» TIMEOUT: Provides the time-out time for the connection in seconds.
» BAUD: Provides the connection speed of a serial connection.
PC configuration:

» DEVICE=TCP/IP

» HOST=localhost

» PORT=1101

» TIMEOUT=10

CE configuration:

» DEVICE=COM1

» BAUD=115200

Defines minimum memory (in MB) that must be available on the hard drive.
LOG files are deleted before this value is gone below.

Default: 1024

Defines the maximum memory on the hard drive in MB used for LOG files. LOG
files are deleted if this value is exceeded.

Default: 1024

Defines memory on the hard drive (in MB) that is used even if there are no
LOG files.

Default: 5
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LOGLogLifeTime=

LOGImageCnt=

LOGLogUpdateTime=

LOGMaxBufferedRecs=

LOGMaxLogFileSize=

LOGCheckDiskTime=

INIT=

Defines the lifecycle of the LOG files in seconds. Older LOG files are deleted.
Default: 1209600 (corresponds to 14 days)

Defines the number of LOG entries, after which all incremental LOG files are
written.

» 0:inactive (default)

Number of milliseconds, after which the LOG entries received are written to a
LOG file.

Default: 2000

Defines the number of LOG entries that are buffered if they cannot be written
to files.

Default: 10240

Maximal size of a log file in bytes. If a log file reaches this size, it is closed and a
new log file is created.

Default: 5242880 (corresponds to 5 MB)

Defines the interval in seconds, in which the memory occupied by LOG files is
checked.

Default: 60
Action when starting the application with Windows CE:
» 0:endimmediately

» 1 (or other value greater than 2): Open listening port in minimize to
system tray

» 2:only display surface
Default: 1

Note: As part of the separation of zenSysServ and zenLogServ for zenon 7.00,
this default value was also changed for other versions. The default value was
previously 2.

DIAGNOSIS SERVER FROM VERSION 7.00 SPO

INI entry

[LOGGING_SYSTEM]

LOGDirectory=

Description
Section in zenon6.ini.

Contains parameters for the Diagnosis Server. Only affects zenLogSrv and has
no effect on zenSysSrv.

Defines the folder for the LOG files.
If there is no entry, the following is used as a standard value:

» The path extracted from the Registry,
for example: %ProgramData%\COPA-DATA\LOG

» the LOG folder in the ProgramData folder of the zenLogSrv, if no path is

14



Diagnosis Viewer

Zzenon

defined in the registry,
e.g. $ProgramData%\COPA-DATA\zenon700\L0OG




CONFIG=

LOGMinFreeDiskSpace=

LOGMaxUsedDiskSpace=

LOGMinUsedDiskSpace=

LOGLogLifeTime=

LOGImageCnt=

LOGLogUpdateTime=

LOGMaxBufferedRecs=

LOGMaxLogFileSize=

Configuration string for the Diagnosis Server. The string consists of the
following parts:

DEVICE=TCP/IP; HOST=[Hostname] ; PORT=[Port]; TIMEOUT=[T1i
meout]

» DEVICE: Sets the communication type used and must always be set to
TCP/IP

» HOST: Is set to the computer name of the Diagnosis Server.

» PORT: states the port to be used.

» TIMEOUT: Provides the time-out time for the connection in seconds.
Configuration:

» DEVICE=TCP/IP

» HOST=localhost

» PORT=50780

»  TIMEOUT=10

Defines minimum memory (in MB) that must be available on the hard drive.
LOG files are deleted before this value is gone below.

Default: 1024

Defines the maximum memory on the hard drive in MB used for LOG files. LOG
files are deleted if this value is exceeded.

Default: 1024

Defines memory on the hard drive (in MB) that is used even if there are no
LOG files.

Default: 5
Defines the lifecycle of the LOG files in seconds. Older LOG files are deleted.
Default: 1209600 (corresponds to 14 days)

Defines the number of LOG entries, after which all incremental LOG files are
written.

Default: 0

Number of milliseconds, after which the LOG entries received are written to a
LOG file.

Default: 2000

Defines the number of LOG entries that are buffered if they cannot be written
to files.

Default: 10240

Maximal size of a log file in bytes. If a log file reaches this size, it is closed and a
new log file is created.

Default: 5242880 (corresponds to 5 MB)

16



Diagnosis Viewer

Zzenon

LOGCheckDiskTime=

Defines the interval in seconds, in which the memory occupied by LOG files is
checked.

Default: 60

INIT=

Action when starting the application with Windows CE:
» 0:endimmediately

» 1 (or other value greater than 2): Open listening port in minimize to
system tray

» 2:onlydisplay surface

Default: 1

DIAGNOSIS CLIENT BEFORE VERSION 7.00 SPO:

[SYS_REMOTE]

Section in zenoné6.ini.

Contains parameters for the Diagnosis Client.

LOG_CONFIG=

A configuration string for the Diagnosis Client is stored here. The string consists
of the following parts:

DEVICE=TCP/IP; HOST=[Hostname]; PORT=[Port]; TIMEOUT=[T1
meout]

» DEVICE: Sets the communication type used and must always be set to
TCP/IP

» HOST: Is set to the computer name of the Diagnosis Server.

» PORT: states the port to be used.

» TIMEOUT: Provides the time-out time for the connection in seconds.
Configuration:

» DEVICE=TCP/IP

» HOST=localhost

» PORT=1101

» TIMEOUT=10

DIAGNOSIS CLIENT FROM VERSION 7.00 SPO

[LOGGING_SYSTEM]

Section in zenoné6.ini.

Contains parameters for the Diagnosis Client.

LOG_CONFIG=

A configuration string for the Diagnosis Client is stored here. The string consists
of the following parts:




DEVICE=TCP/IP;HOST=[Hostname]; PORT=[Port]; TIMEOUT=[T1i
meout]

»  DEVICE: Sets the communication type used and must always be set to
TCP/IP

» HOST: Is set to the computer name of the Diagnosis Server.

» PORT: states the port to be used.

» TIMEOUT: Provides the time-out time for the connection in seconds.
Configuration:

» DEVICE=TCP/IP

» HOST=localhost

» PORT=50780

»  TIMEOUT=10

NOTE:

INIT UNDER CE

Under Windows CE we urgently recommend to not set entry INIT= (in section [LOGGING_SYSTEM] or
[SYS_REMOTE]) to value 2.

Reason: The value 2 means that both syssrvcE and LogsrvCE only display the user interface and do
not open the listening port.

If now a Diagnosis Client wants to establish a connection, it will fail. As in this case the Diagnosis Clients
start process LogsrvCE and the process does not open the port, each Diagnosis Client starts such a
process. This leads to several parallel LogSrvCE processes and to a delay in starting the Diagnosis Clients
as it waits for the timeout of the connection while establishing the diagnosis connection.

ZENLOGSRV ON A SYSTEM WITH DIFFERENT VERSIONS

If zenLogsrv is used on a system with different versions as a central local diagnosis server, the entry
LOG_CONFIG in the [sYs_REMOTE] such must be as follows:
DEVICE=TCP/IP;HOST=localhost; PORT=5780; TIMEOUT=10

Reason: Older clients then use zenLogsrv as the Diagnosis Server. New clients do this automatically.
This service is switched on automatically on the PC when the system is started; it must be started
manually with CE.

Attention: If the port cannot be reached, older clients start zensyssrv and retry connecting to it.

18



3.3.2 Windows CE

Under Windows CE the Diagnosis Server is started as an application.
At the configuration (on page 12) of the connection consider the recommendation for parameter INIT:

Under Windows CE we urgently recommend to not set entry INIT= (in section [LOGGING_SYSTEM] or
[SYS_REMOTE]) to value 2.

Reason: The value 2 means that both syssrvCE and LogsrvcCE only display the user interface and do
not open the listening port.

If now a Diagnosis Client wants to establish a connection, it will fail. As in this case the Diagnosis Clients
start process LogsrvCE and the process does not open the port, each Diagnosis Client starts such a
process. This leads to several parallel LogSrvCE processes and to a delay in starting the Diagnosis Clients
as it waits for the timeout of the connection while establishing the diagnosis connection.

USER INTERFACE UNDER CE

TRANSPORT SERVICE (ZENSYSSRV)

i 1 ' Transport Service &J‘
l Start l ‘ Browse ‘ ‘ Stop ‘
Configuration:

‘ Hide ‘
| Bt |
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Parameters Description

Start Opens the Listening port and enables zensyssrv to receive
Remote Transport commands.

B . . .

rowse Opens the dialog for browsing the file system.

Stop . ..

Terminates the receiving of Remote Transport commands and
closes the Listening port.

Configuration Selection of an existing server configuration from drop-down list.
New connections cannot be configured. See section Entries in
zenonb.ini (on page 12) for the configuration of the connection.
Available are:

» Configuration from zenon6.ini

» Standard configuration for TCP/IP

» Standard configuration for COM1 to COM4
ide Minimizes the user interface into the task bar.

Exit . . . . . .
Terminates the application and closes the Listening port if
necessary.

X

. Minimizes the user interface into the task bar.
(button top right)

LOGGING SERVICE (ZENLOGSRV)

i ' Logging Service

S

Configuration:

‘ Hide ‘

| Ext |




Parameters Description

Start Opens the Listening port and enables zenLogsrv to receive log
entries.

Stop . .o . . .
Terminates the receiving of log entries and closes the Listening
port.

Configuration Selection of an existing configuration from drop-down list. New
connections cannot be configured. See section Entries in
zenonb.ini (on page 12) for the configuration of the connection.
Available are:

» Configuration from zenon6.ini
» Standard configuration for TCP/IP

Hide Minimizes the user interface into the task bar.

Exit . . . . . .
Terminates the application and closes the Listening port if
necessary.

X

Minimizes the user interface into the task bar.

(button top right)

3.4

Diagnosis Server

The Diagnosis Server:

>

>

Creates and manages log files.

The Server is:

e implemented from zenon 7.00 on as zenLogSrv

e up until zenon 6.51 integrated in the zenSysSrv.

The configuration of the server is read from the zenoné6.ini (on page 12).
The server writes the received log data into the log file.

The saving location for the files has to be configured. Standard:
$ProgramData%$\COPA-DATA\LOG\

Log files are named after the following fashion LOG<YYMMTThhmmss>. txt.
The server is multi client able. Several evaluations can connect to the server simultaneously.
It is possible to connect to the server onling, to see the current logging messages.

It is possible to connect to diagnosis servers other than the local and to execute the same tasks
(configuring server, configuring clients, online logging) as on the local server.
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» The parameters of the current server (with which the Diagnosis Viewer is connected) can be
modified. If a modification of another diagnosis server is needed, the server connection can be
changed in the menu under File — Connect to....

» The menu entry Ssettings - Server configuration is only available, if online logging is not used
at the moment.

34.1 System integrity monitoring

At the start of the Runtime a monitoring thread with high priority is also started. The monitoring thread
checks critical parameters every ten seconds and writes corresponding warnings or errors in module
Supervisor of the Diagnosis Server.

The following parameters are monitored.

Parameters Limit
Warning threshold for used handles > 5000
Error threshold for used handles > 9000
Warning threshold for used GDI objects > 5000
Error threshold for used GDI objects > 9000
Warning threshold for CPU use for the main thread >70%
Error threshold for CPU use for the main thread >90 %
Warning threshold for total CPU use >70%
Warning threshold for total CPU use >90 %
Warning threshold for free main memory <30%
Error threshold for free main memory <10%
Warning threshold for OnTimer in the main frame > 1000 ms
Error threshold for OnTimer in the main frame > 5000 ms

3.4.2  Settings of the server

The Diagnosis Server can be configured via entries in file zenon6.ini or via dialog server configuration
in the Diagnosis Client. We recommend to do the settings in file zenon6.ini.
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CONFIGURATION VIA ZENONSG6.INI

See section Entries in zenon6.ini (on page 12).

CONFIGURATION VIA DIALOG

To configure the Diagnosis Server via the dialog:

1. start the Diagnosis Viewer

2. open entry File Connect to... (on page 30).

3. configure the desired Server

(Take care of the correct port selection depending on the version!)

4. open entry Settings -> Server configuration

5. configure the events which should be logged

6. Close the dialog by clicking on ox.

Note: All changes are written to zenoné6. ini when the dialog is confirmed.

Configuration of the events which should be logged by the Diagnosis Viewer:

r

.
Diagnosis server configuration ﬁ
Messagelevel
Modules LOGImageCnt 0
GENERAL [V]Errors pace 1]
LOGMinFreeDiskSpace [MB:
NET |:| Warnings 1024
PROXY .
o8 [ Success LOGMaxUsedDiskSpace [MB] 1024
SYSSRY [ Failed LOGMinUsedDiskSpace [ME] 5
DRV
LoG [ internal LOGLogUpdateTIme [ms] 2000
[[Message LOGMaxBufferdRecs 10240
[Cpebug LOGMaxLogFileSize [BYTE] 5242330
7| Deep Debug .
LogDirectory C:\ProgramData\COPA-DATALOG (]
LOGLogLifeTime [s] 1209600
LOGCheckDiskTime 50
Message level for all modules ] [ Default values ] [ Accept ] [ Cancel ] [ Ok
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Parameters
Modules

Messagelevel

LOGImageCnt

LOGMinFreeDiskSpace

LOGMaxUsedDiskSpace

LOGMinUsedDiskSpace

LOGLogUpdateTime

LOGMaxBufferedRecs

LOGMaxLogFileSize

LOGDirectory

LOGLogLifeTime

LOGCheckDiskTime

Message level for all
modules

Default values

Accept

Description
Selection of the modules which you want to configure.

Selection of the events which should be logged.
Default: Errors

Number of records, after which all incremental fields will be written.
Default: 0 (not active)

It is continuously checked, if less than the configured minimal free disk
space is available. The oldest log files are deleted. Minimal free disk space in
MB, before log files are deleted.

Default: 1024 MB

Maximal used disk space for the log in MB.
Default: 1024 MB

Minimal used disk space in MB independent whether LOGMinFreeDiskSpace
is under-run.
Default: 5 MB

Time in ms, after which the received entries are saved.
Default: 2000 ms

The server buffers the contents of all incremental log fields for diverse
applications, in order to be able to write images of them into the log file.
With the start of a log file and after configurable number of log entries a
complete image for all addresses is written into the log file.

Received data are written to the log files. The entry is done via temporary
buffer. It can be configured whether the data should be written immediately
or delayed.

Number of buffered entries if they cannot be saved.

Default: 10240

The server writes the received log data into the log file. If this log file
reaches the configured size, a new file is started.

Maximal size of a single log file in bytes.

Default: 5 MB

Folder in which the log files are written.
Default: $ProgramData$\COPA-DATA\LOG\

It is continuously cheked, if the lifetime of the log files is exceeded.
The oldest log files are deleted.

Number of seconds to keep the log files.

Default: 14 days

Time in sec, in which the used disk space id checked.
Default: 60 s

Settings are taken over for all modules.

Restore default settings.

Take over settings for this module.
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Cancel Discards changes and closes dialog.

OK Applies changes and closes dialog.

3.5 Diagnosis Client

All programs which create log entries are Diagnosis Clients. These log entries are sent to the Diagnosis
Server via TCP/IP. Server computer and port are read - dependent on the used version - from the local
zenon6.ini (on page 12) and contacted. If the connection fails the following procedure is carried out
cyclically:

» If the Diagnosis Server cannot be reached, a attempt to reconnect is made every 500 ms.

» If no connection could be established after half the timeout time, the system tries to start the
service zenSysSrv or zenLogSrv.

The settings are configured via entry LOG_CONFIG= in section [SYS REMOTE] (up to 6.51) or
[LOGGING_SYSTEM] (from 7.00).

CONFIGURATION DIAGNOSIS CLIENT

To configure the Diagnosis Client via the dialog:
1. start the Diagnosis Viewer

2. open entry Settings -> Client configuration
(only available if logging is inactive)

highlight a Client

clickon List of parameters

The dialog for configuration is opened
configure the Client

Close the dialog by clicking on ok.

© N o U B~ W

repeat the procedure for other Clients if necessary
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Diagnosis Viewer

Zzenon

CLIENT LIST

M

DiagViewer - CDSBG071.56G.COPADATA,.COM: 1163
2enDBSry - CDSBGO71.5BG.COPADATA.COM: 1053
ZENONE3Z - CDSBGO71.58G. COPADATA.COM: 1166

Refresh | List of parameters I Close |

Clients Lists all available Clients.

Refresh Updates the list of the Clients.

List of parameters Opens the dialog for configuring the selected Client.
Close Closes the dialog.

CONFIGURE CLIENT

(zmoufaz - CDSBGO71.5BG.COPADATA.COM 1166
Modules | M level ok I
General

E
Net = &qes Cancel I
Pgaxy I~ Warnings
D
SysSry [~ Success ﬂl
Driver .
Log I~ Failed Default vaIuesI
SAT I~ Internal
Project
User I~ Message
Stringlist
Connections I~ Debug
Archive
Variables I DeepDebug
Types
PFS
All None I

Message level for all modules I

maximal bufferd records | 256

The available standard modules:




Parameters

Modules

Messagelevel
All
None

Message Level for all
Modules

Max Buffered records

OK
Cancel
Accept

Default wvalues

Description
Selection of the modules which you want to configure.

The list is made up of standard modules and modules dependent on the
respective client.

» General: General messages

» Net: Network messages

» Proxy: Messages of the zenon Proxy

» Db: Messages of ZenDbSrv

» SysSrv: Messages of ZenSysSrv

» Driver: Messages from a driver

» Log: Messages from logging

» SAT: SICAM 230 specific messages
Type of information which should be logged.
Selects all.

Deselects all.
Assigns highlighted message levels to all modules.
Number of records to be buffered if no connection to the server is

established.
Default: 256

Applies all changes and closes dialog.
Discards all changes and closes the dialog.
Applies all changes. The dialog remains open.

Enters the default values.

3.6 Diagnosis Viewer - Analysis Program

The Diagnosis Viewer is used to display the log data. It connects to the Diagnosis Server in order to display data
online or read back historic log files. Log files contain not only the log data, additional information which is
important for the analysis such as column headings are also saved in them.

To display a log file:

1. select File -> Open

2. the dialog for selecting a log file is opened with focus on the configured default folder

3. select the desired file
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Diagnosis Viewer ﬂ

Zzenon

4. the logfile is displayed
2. Diagnosis Viewer - [LOG050304072743.TXT, LOG050304072743 8%
Eile View Settings Windows Help -5 X
=
A ERAA RIS
Record version | Record tpe | IP address Process ID | Log ID | Thraad ID | Timestamp | Message level E]
7] enter . 7 ¢ 7] enter. | e ] ente. ] Enter - 7] nt v|=
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166 @036 403200 ALL
oL L 192168023 4352 1166. 5812 403200, ALL
oL L 192168023 4352 1166.. 5812 0403 200
192168023 . 139 AL
192168023 1166 1396 ALL
192168023 1166 1396 403200, ALL
192168023 1166 1396 403200, ALL
192168023 1166 1396 403200, ALL |
= e P Y T M
o ] EY
|Lines read 369, incorrect lines: O |Calor aption for IP
Reacy [ [localhost MU Y|
5. Double click an entry to open the detail view

RECOGNIZING QUEUE OVERFLOW AT DRIVER

If messages of a driver are deleted because of queue overflow, the Diagnosis Client and the Diagnosis
Server set a marker in the new entry when writing a new entry for all activated modules (on page 37)
that older entries were deleted from the queue. The overflow recognitions contained in the opened log

files are counted:

£). Diagnosis Viewer - [LOG100429062607.TXT] =)
[ Bl Settings View Windows Help =i®ix
2 BSh 864D @]t -
({ Record version )P address ProcessiD LoglD  TheeadD £ Timestamp Messagelevel Module Name of log connection  Computer name Error text -
02 1921680.. 328 0 248 20/M42010062605415058 ALL SYSSRV  ZenSysSev
02 1921680.. 3228 0 248 29042010 06:2605415054  ALL SYSSRV  ZenSysStv SysSv Info InitStr
] 1921680.. 1376 1266552 %6  2D4010062605691220 ALL L0G  zenDBSw CDS8GOT
02 1921680... 1376 1266552 215  204201006:2605692221 ALL L0G  zenDBSw CDSBGOTY .
0 1921680... 3228 0 3820 20042010062605712233 ALL SYSSRV  ZenSysSrv SysSrv Client:COS
02 1921680... 1376 11266552 1168 29042010 06:2605,718236  ALL LoG 2enDBSev C0S8GOTS
02 1921680... 1376 11266552 3816 29042010 06:2607 474289  ALL o8 2enD8Sev CDS8GOT9 *+*** Init zenDbse
02 1921680.. 328 0 345 29042010054102056715 AL SYSSRV. ZenSysSrv Syssrv Client:COS
82 1921680... 700 46738584 4760  20042010064102086715 ALL L0G  DisgViewer CDSBGOTY
02 1921680... 3228 0 348 20420100701:19.271715 ALL SYSSRV  ZenSysSev SysSrv Client:CDS
02 1921680.. 328 0 5088 290420100704:21, 575715 ALL SYSSRV  ZenSysSrv SysSrv Client:COS
| 82 1921680.. 1580 “USNE 4564 29042010 07:04:21,605715  ALL LOG  DiagViewer CDSBGOTS
0 1921680... 3228 0 5068 29/42010074815179715 ALL SYSSRV  ZenSysSrv SysSrv Client:CDS
b 1921680... 328 0 840 20042010 07:1829126715  ALL SYSSRV ZenSysSev SysSev Client:COS
82 ) 1921680.. 084 6199480 2092 29042010 071819156715 ALL L0G  DugViewer COSBGT
| 1921680.. 3228 0 %0 204201007:23:14 090715 ALL SYSSRV  ZenSysSrv SysStv Client:COS
[ 1921680.. 328 0 04 29042010 074239128715 ALL SYSSRV  ZenSysSrv. SysSrv Client:COS
| 82 1921680.. 4740 B6600 1716 204010074239157715 ALL LOG  DisgViewer CDSBGOT
02 1921680... 3228 0 5084 20042010 074311428715 ALL SYSSRV  ZenSysStv SysSrv Client:COS
02 1921680.. N8 (] 4868 29042010 07:44:46,537715  ALL SYSSRV  ZenSysStv SysSrv Client:CDS
2 1921680.. 103 4SI65720 3588 29042000 076567715 ALL LOG  DiagViewer CDSBGIT
?] 1923680, VR n - 4RRR 2904010 074213407715 AN SVSSRV  TenSueSry. ‘v&vﬂiﬂnﬂ";ﬁ'
e —
|selected: 0 Lines read: 67, incorrect M Profile: test Color option for log connection
Resdy Connected to: localhost




Parameters Description

Column Record version This column must be part of the column selection. It shows the
version of the data record. Version 8x tags overflows.

Counter 82 8 refers to overflow, 2 refers to the concerned version of the data
record.
Status line queue overflows If status bar is active, the number of overflows is displayed there.

Note: Not all entries written in the log file are displayed. If a not displayed log data record is tagged with
an overflow, it will be displayed at the next visualized data record of this client. If several not displayed
entries in a row are tagged with an overflow, the counter in the status bar can deviate from the number
of data records with overflow tags.

3.6.1 Global settings

The entries are in the English language.
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Parameters
File

Open

Open to active
document

Close
Save

Save as

Remote Download

Connect to

Online

Offline

Exit

Description
Commands in menu File.

Opens dialog for selecting a log file saved in TXT format. Each newly opened log
file is displayed in its own window.

Each new log file is added to the active window.

Closes the active window.
Saves the log files of the active window.

Saves the current view of the active window (e.g. filter settings) to a file to be
selected.

Only available, if a connection to a Remote Diagnosis Server exists. Enables the
download of logging files of the Remote Server to the local log folder. A
subdirectory with the name of the PC is created. Only file, which have changed or
which are new, are available.

Opens the dialog for the Connection selection (on page 22).

Activates the online error view.
If online logging is started, all incoming entries are displayed. The same filter
dialog as for reading files can also be set here.

Difference: If no log connection is selected, all incoming log entries will be
displayed, otherwise only the ones from the selected clients.

If the filter of the log connection is modified, all entries not fulfilling the filter
criteria will be lost. (Logging file nevertheless is created and all entries are saved.)
Displayed entries can be saved.

Deactivates the online error view. (Default)

Closes the Diagnosis Viewer.

Connection settings Diagnosis Server connection

The Diagnosis Viewer automatically connects to a selected standard Server at the start. If no standard
server is defined, localhost is used as standard server. The Server configuration can also be done via
zenonéb.ini (on page 12) (recommended).
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SELECT DIAGNOSIS SERVER

Click on File -> Connect to... to open the dialog for selecting a Server:

e s =

Diagnosis Viewer

Zzenon

State Diagnosis server name 7™ Port Timeout OK
Con;Def localhost 50780 10
Mew server

List Server Lists all configured Servers and displays them:

) Status

» Name

> Port

> Timeout
OK Applies settings and closes the dialog.
Cancel Discards settings and closes the dialog.
New Server Opens the dialog for configuring a new Server.
Delete Server Selected Server entry is deleted from the list.
Edit Server Opens the dialog for configuring the selected Server.
Connect to Establishes a connection to the selected Server.
As default Selected server becomes the standard server.




Diagnosis Viewer

Zzenon

CREATE AND EDIT DIAGNOSIS SERVER

Click on New server or Edit Server in dialog Diagnosis Server connection to open the dialog for
configuring the Server:

SEerver name: | oK I
|

Port:
50730

Timeout:
10

Server name Name of the PC to which to connect.

The following must run on the PC:
up to version 6.51: zenSysSrv

from version 7.00: zenLogSrv

Port Port of the service on the target computer:
up to version 6.51: 1101
from version 7.00 on: 50780

Timeout Time in seconds to wait for a response from the Sysservice.
Default: 10 s
OK Applies settings and closes the dialog.

Cancel Discards settings and closes the dialog.




Column settings

Diagnosis Viewer

Zzenon

A number of pre-defined columns can be selected in the menu under Settings -> Column settings. These
columns and their entries are automatically displayed on opening a new file. Also the sorting and the
column width of the selection are regarded. On opening the column width has to be set to Autosize.

M

Column selection
available:

ID ¥  Column name ‘o
i Record version
i Record type
2 Thread name E
5 Assert condition
9 Project GUID
10 Project path
i1 Sent Data
12 Received data
23 Metwork port no.
24 Server name
25 Standby name
26 Client name
27 Server IP
28 Standby IP
29 Client IP
an Binaru hiiffar i

selected:

L3

bin] Column name

IP address

Process ID

Log ID

i Thread ID

i |Messagelevel |
i Timestamp

Mame of log connection
Module

Mame of source files
Source line

m

M A

Computer name
Function name
Project name

no. serial interface

Raudrata
I ] *

ESpEN

bt;m‘-.la\-bw_'

rom

[_ok ] [[bbrechen |

available available columns

selected Columns which are displayed

> adds columns selected at "available" to "selected"

>> adds all available columns at "available" to "selected"

< removes selected columns from "selected"

<< removes all available columns from "selected"

~ sorts selected entries one level higher (multi-select is possible)
v sorts selected entries one level lower (multi-select is possible)
OK Applies settings and closes the dialog.

Cancel Discards settings and closes the dialog.

Columns can also be configured via the context menu:




Parameters

Add all columns with
entry

Remove Column

Remove all empty
columns

Column width automatic

All columns widths
automatic

Description

Adds all columns which contain entries.

Hides the selected column.

Hides all columns which do not contain entries.

The width of the selected column is automatically adjusted to the longest
entry

The width of all columns is automatically adjusted to the longest entry

3.7 Possibilities of Filtering

To define filters open the corresponding filter dialog via the corresponding symbol or the tab of the

filter.

SYMBOL BAR FILTER

To use the symbol bar, you must activate it in menu view via menu item Icon bar.

(R -
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1 Change pre-filter Opens dialog with five tabs for defining filters.
settings

2 Change pre-filter for Opens tab IP address - Process No - Log ID (on page 36) .
IP-ProcessID-LogID

3 Change pre-filter for Opens tab Modules (on page 37).
modules

4 Change pre-filter for Opens tab Additional columns (on page 38).
additional columns

5 Change pre-filter for Opens tab Time interval (on page 39).
time interval

6 Change pre-filter for Opens tab Colors (on page 40).
coloring

FILTER DIALOG

o T ey |

available:

IP address - Process No-Log 1D | Modules | Additional columns [ Time interval | Colors |

selected:

Log connection ¥

Log connection ¥

Intern_WELT _Treiber fiir interne Vari...
MATHDR32_WELT _Treiber fiir Mathe...
SIMUL32_WELT_SIMUL_WIZ
SIMUL32_WIZARD_SIMUL_WIZ
SYSDRY_WELT _Treiber fur System-V...

intern
mathdr32

simul32
sysdry
zenDBSrv
zenLogSrv
zenone32
zenrt32

[ ok | [ abbrechen




Diagnosis Viewer

Zzenon

IP-ProcessID-LogID

Opens tab IP address - Process No - Log ID (on page 36) for
configuring the connection which should be logged.

Modules

Opens tab Modules (on page 37) for the modules which should be
logged.

Additional columns

Opens tab Additional columns (on page 38) for selecting additional
columns which should be displayed.

Time interval

Opens tab Time interval (on page 39) for defining time filter.

Colors

Opens tab Colors (on page 40) for selecting the color-coding of
information.

371 IP address - Process No - Log ID

Configuration of the connections and processes which should be displayed.

o T ey |

IP address - Process No-Log 1D | Modules | Additional columns [ Time interval | Colors |

available:

Log connection ¥

M A

selected:

Log connection ¥

Intern_WELT _Treiber fiir interne Vari...
MATHDR32_WELT _Treiber fiir Mathe...
SIMUL32_WELT_SIMUL_WIZ
SIMUL32_WIZARD_SIMUL_WIZ
SYSDRY_WELT _Treiber fur System-V...
intern

mathdr32

simul32

sysdry

zenDBSrv

zenLogSrv

zenone32

zenrt32




Diagnosis Viewer
zenon

available List of available connections.
selected List of selected connections.
Pfeiltasten Add selected (>) or all (>>) connections to list selected or removes them from

the list (< or <<).

OK Applies all changes on all tabs and closes the dialog.

Abbrechen Discards all changes on all tabs and closes the dialog.

3.7.2 Modules

Selection of the modules which should be displayed.

| 1P address - Process No-Log ID | Modules | additional columns | Time interval | Colors |

Module filter active

available: selected:
Modules + Modules + e
GEMERAL

MNET

M A
B M
8§

GetSetSrvParam
SAT

Project

User

Stringlist
Connections
Historian
Variables

Niats hunae




Diagnosis Viewer
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Module filter active

Active: Itisfiltered on modules.

With this only log data records are displayed which are assigned
to a selected module.

available

Available modules.

selected

Selected modules.

Cursor keys

Add selected (>) or all (>>) connections to list selected or removes
them from the list (< or <<).

OK

Applies all changes on all tabs and closes the dialog.

Cancel

Discards all changes on all tabs and closes the dialog.

3.7.3 Additional columns

Selection of the columns which should be displayed additionally.

available:

Column name ¥

Archive

Arv short
Arv var idx
D

Type id
Type name
Parentid
Parent name
Driver id
Driver name
Driver descr.
Action
Command
Picture
ILock state

Pirdirmizatine Marme

M A

o T ey |

| IP address - Process No-Log ID I Moddes| Additional colurnns |r.||e interval I Cokws|

selected:

Column name ¥

ESpEN




Diagnosis Viewer
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available

List of the available columns. All field definitions existing in the file are displayed.

selected

List of the selected columns.

Cursor keys

Add selected (>) or all (>>) connections to list selected or removes them from
the list (< or <<).

OK

Applies all changes on all tabs and closes the dialog.

Cancel

Discards all changes on all tabs and closes the dialog.

3.7.4 Time interval

Configuration of the time filter for displaying the entries.

| 1P address - Process No-Log ID | Modules | Additional columns | Time interval | Colors |

Start time:
[E.03.2011 2 wisss =i
End time:
(=] .0 (=]
18.03.2011 5 1zoo:12 |
Reset time interval

[ ok | [ abbrechen
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Start time:

Selection of the date and point in time from which entries should be
displayed.

Default: actual date

End time:

Selection of the date and point in time up to which entries should be
displayed.

Default: actual date

Reset time interval

Sets filter back to default value.

OK Applies all changes on all tabs and closes the dialog.
Cancel Discards all changes on all tabs and closes the dialog.
3.75 Colors

Selection of the color-coding of the information.

[ 1P address - Process No- Log ID | Modles | Additional columns | Time interval | Colors |

Color for:

() IP address

() Modules

() Log connection

() no colors




Parameters Description

Colors for: Selection of the color

IP address Active: Different IP addresses are colored differently.

Modules Active: Different modules are colored differently.

Log connection Active: Different names of the log connection are colored differently.
no colors Active: Entries are not colored.

OK Applies all changes on all tabs and closes the dialog.

Cancel Discards all changes on all tabs and closes the dialog.

3.8 Reading the log files

One or more log files can be opened in an analysis at the same time. A pre-filter (on page 34) has to be
set to limit the display. This is possible with five property pages. This filter can be modifies later on. If
the filter is set, only the entries fulfilling these filter criteria are displayed. The entries are listed
chronologically.

FILTER COLUMNS

Another filter possibility is available with the filter columns. Filter criteria can be entered for each
column in the input field below the column header. The fields support regular expressions, so that also
complex filter criteria can be defined. The list can be sorted ascending or descending by clicking the
column headers. Displayed entries can be saved. Fields to be displayed can be selected using the
Settings -> Column settings menu entry.
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STANDARD FIELDS IN THE LOG FILE:

IP address

IP address.

These fields identify the clients and allow the message to
be assigned.

Log ID

entry ID

These fields identify the clients and allow the message to
be assigned.

Message Level

Name of the message level for which the message was
entered.

Module

Name of the module, which entered the message.

Process ID

ID of the project.

These fields identify the clients and allow the message to
be assigned.

Record type

Type of entry.

Record version

Version number of the entry.

Thread ID

ID of the thread, from which the message was entered.

Timestamp

Time of the message in UTC.

OPTIONAL FIELDS WITH FIX ID.

1 Name of log connection Name of logging connection
2 Thread name Name of the threads.

3 Name of source files Name of the source file.
4 Source line Source line

5 Assert condition Assert condition

6 Computer name Computer name

7 Function name Function name

8 Project name Project name

9 Project GUID GUID of the project.
10 | Project path Project path

11 | Sent Data Sent data

12 | Received data Received data




13 | no. serial interface Number of the serial interface.
14 | Baudrate Baud rate

15 | dtr setting DTR setting.

16 | rts setting RTS setting.

17 | Serial char. length Serial character length
18 | Parity Parity

19 | No. stopbits Number of stop bits

20 | CTs CTS.

21 | dsr DSR

22 | dsr sensitivity DSR sensitivity.

23 | Network port no. Port number in the network.
24 | Server name Server name.

25 | Standby name Name of standby server
26 | Client name Client name.

27 | Server IP IP address server.

28 | Standby IP IP address standby.

29 | Client IP IP address client.

30 | Binary buffer Binary buffer.

31 Pointer Pointer

32 | Class name Class name

33 | Error code Error code:

34 | DLL instance handle DLL instance handle

35 DLL name DLL name

36 | Driver error parameter 1 Driver error parameter 1
37 Driver error parameter 2 Driver error parameter 2
38 Trace Message Trace message

39 Errortext Error text

40 | Error file name Name of error file.

41 | Success condition Condition for success

42 | Value if successful Value when successful
43 | Net adress Net address:
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44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62

63

3.9

Datablock
Offset

Bit number

Area in PLC
Communication direction
General text
Main version no.
Sub version no.
Build no.
Servicepack
Hotfix no.

Sending client

Target client for command

Database no.
Datapoint no.
Datapoint value
Datapoint status
Datapoint timestamp
Duration in ms

Number, counter

Structure of the log file

Data block.
Offset:
Bit number

Area in the PLC.

Shows the direction of the communication in a string.

General text

Number of main version.
Number of sub-version.
Build number.

Service Pack.

Hotfix number

Client, which sent the command

Client that is the target of the command.

Number of database.

Datapoint number (channel number)

Value of datapoint

Status of datapoint

Time stamp of datapoint in seconds

Error wait time in milliseconds.

number, counter.

Log files are ANSI text files. The single fields are separated by tabs. The final character is CR+LF. So, the

Notepad can be opened to display the files.

Log files contain information sequentially, not chronologically sorted.
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3.9.1 Message levels

Eight groups exist for the subdivision of log messages. They are bit coded and therefore can be
combined.

1 Error messages
2 Warnings

4 Success message
8 TRACE

16 ASSERT

32 Log messages
64 Debug

128 Extended debug

3.9.2 Search function

With view/Find the current window can be searched. All hits are marked.

3.9.3 Profiles

Column settings can be saved as profiles.

To save profiles:
1. enter a name into the filed in the tool bar

2. click on the disk symbol on the right-hand side

To load profiles:
1. select a saved profile from the combo box

2. click on the second symbol on the right-hand side with the disk

The profiles are saved a *.lvs files.



3.10 Handling of errors and messages for the Diagnosis Viewer

ERROR

Error

The port cannot be opened.

Diagnosis Clients do not start the
zenlLogSrv

Under CE many processes are created
by SysSrvCE.exe or LogSrvCE.exe.

Several processes crash.

(Unhandled Exceptions of the
Diagnosis Server at receiving log
messages or configuration commands
or of the Diagnosis Client and
Diagnosis Viewer during booting or
during receiving the configuration)

LOG ENTRIES

Entry

Possible causes

4

Another application uses the port.
Check via "netstat".

The ports for entries

[sYs_REMOTE] CONFIG and

[LOGGING_SYSTEM] CONFIG

are identical. zenLogSrv and zenSysSrv then try to open the
same port.

zenAdminSrv was terminated. Without it the service cannot
be started.

zenLogSrv is not registered as a service at the PC. In this case

enter the following in the command line: zenLogSrv.exe
—-Service

Diagnosis Clients are not of version 7.00 SPO or higher. The
zenLogSrv is only supported from this version on.

Under Windows CE: The individual components (Runtime,
SysSrvCE, LogSrvCE) are located in different folders. They must
be located in the same folder. Otherwise the components do
not find one another.

One of the two entries in zenon6.ini

[sYs_REMOTE] INIT or

[LOGGING_SYSTEM] INIT

has the value 2.

As a result the application only displays the user interface and
does not open the Listening port. Each Diagnosis Client then
tries to start the process as it cannot connect to the Diagnosis
Server.

The versions do not match. Diagnosis Clients, Diagnosis Server
and Diagnosis Viewer must either all have version 7.00 SPO or
higher or all version 6.51 SPO or earlier (see Compatibility (on

page 7)).

Description
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SysSrv received not supported
network message!

LogSrv received not supported
network message!

Could not open listening port.
Server will be stopped.

zenSysSrv received a network telegram which is not supported.
Example: Log entries.

zenLogSrv received a network telegram which is not supported.
Example: Remote Transport commands

The zenLogSrv or the zenSysSrv could not open its Listening
port. The error message is logged as follows:

» zenlogSrv and zenSysSrv at PC:
Entry in the Windows event display.

» zenSysSrv under CE:
Message box for the user and log entry to the Diagnosis
Server.

» zenLogSrv under CE:
Message box for the user.

The following log entries are assigned to different systems. The first part of the messages states whether

service or Client are effected:
»  SysSrv: zenSysSrv
» SysCli: Client to the zenSysSrv
» LogSrv: zenLogSrv
» LogCli: Diagnosis Client
Entry

[SysSrv/LogSrv/SysCli/LogCli]
Info InitString [String]

[SysSrv/LogSrv/SysCli/LogCli]
WINSOCK ERROR
[SysSrv/LogSrv] Accept Failed!

[SysSrv/LogSrv/SysCli/ LogCli]
Write Faild

[SysSrv/LogSrv] Client
[String] in List Delete!

[SysSrv/LogSrv] Client
[String] in List Insert

Description

A network connection has been initialized with the displayed
configuration string. Server opens ports and Clients connect to the
Server.

An exception occurred during a network operation. The details are
also displayed.

An incoming connection from a Client could not be accepted.

Not all data which should be sent could be sent. The number of
the sent bytes and the number of the bytes which should be sent
is displayed.

The Client log off from the Server.

The Client log on to the Server.
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4. Keyblock Runtime Start

Keyblock Runtime Start is a program with which zenon Runtime runs as a shell. In doing so, zenon
Runtime is started, but all Windows system tasks are blocked. Shortcuts such as Windows key or
Ctrl+Alt+Del no longer have an effect. User can no longer access the operating system but only work
on the zenon user interface.

The precondition for this is that the project properties are set Runtime title toNo title (full
screen). Then zenon runs in full screen mode and the Runtime cannot be minimized.

Note also the information provided in the Protect Runtime files (on page 49) chapter.

3 License information

Part of the standard license of the Editor and Runtime.

4.1 Usage

To use Keyblock Runtime Start:
1. inthe Windows start folder under COPA-DATA open the zenon tools
2. Select Keyblock Runtime Start
3. the program starts and automatically starts the Runtime
4. The program blocks all access to the operating system.
e locked shortcuts:
Ctrl+Alt+Del
Ctrl+Esc
Alt+Tab
Alt+Esc
Alt+F4

Windows key

When locking the system keys, the normal operation of the scroll bars with the mouse in the
Runtime is also blocked. You can work around the blocking with the help of the context
menu.

e Hiding the Control Panel in the start menu
e Locking the tool bar for operation

° Prevents
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Changing passwords
Closing Windows
Logout

Locking the computer
User change

¢ Hiding all element in the task manager

¥ Information

If Keyblock Runtime Startis started using the startup process of the operating
system:

» take care that the auto start folder is user-specific: If an other user is logged in, the
program is not executed.

» Processing the startup process programs can be prevented by pressing the Shift key
when the operating system is booting.

This locking cannot be bypassed during Runtime. When the Runtime is closed normally, the system
restrictions are canceled. If the Runtime should be operable without these limitations, the Runtime
must be started instead of Keyblock Runtime Start.

A Attention

Take care that you engineer a possibility to close the Runtime in your project. There is no
possibility to end the Runtime regularly.

» if it can only be ended by turning off the computer
» all system keys are still locked after a restart

To make systems keys available after an irreqular ending (e.g. black out):
» start the Runtime again with the help of Keyblock Runtime Start

» end the Runtime regularly via a close button

4.2 Protect Runtime files

The access to the Runtime files can be strongly restricted and therefore well protected. At this only a
single Windows user has read and write rights for the Runtime folder. All other Windows user do not
have any rights in the Runtime folder including read rights. Operators in the Runtime log on as zenon
user.

In order to limit access to the file system:
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1. Only create a single Windows user (for instance: zenon_aDMIN) who is authorized to start zenon
as well as to read and write in the zenon Runtime folder.

2. Disable access to the zenon Runtime folder for all other Windows users — including read
authorizations!

3. Disable any remote access to the user zenon_ADMIN.
4. Block any software for remote maintenance or remote access such as zenon Remote Desktop.

5. Make sure that zenon can only be started if this user (zenon_aDMIN) is logged in.
Since other Windows users do not have read authorization Runtime will only start in the context
of this user (zenon_aADMIN).

6. Make sure that zenon runs as shell:
a) For this purpose, create a zenon autostart with Keyblock Runtime Start (on page 48)
b) activate the property Lock system keys in the group Runtime settings of project properties
c) start zenon in full-screen mode: Set property Runtime title toNo title
d) also bear multi-screen systems in mind in the configuration
e) disable Explorer start

f) do not offer file selection dialogues
(in this case no functions may be projected which require the user to select files in Runtime)

The access to the zenon file system is then protected.

5. Online updating of the zenon Help:

The Documentation Download Tool administers the updating of your online help including embedded
help, dialog help, tooltips and the PDF product documentation from zenon and zenon Logic.

The updating is carried out online. An internet connection is necessary for this.

CONTENTS OF THE DOCUMENTATION UPDATE:

The Documentation Download Tool supports the updates of:
» zenon and zenon Logic product documentation
» Driver Documentation
» Tutorials

» Glossary
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FILE FORMATS OF THE DOCUMENTATION UPDATE:

The Documentation Download Tool supports the updates of:
» Online help for zenon and zenon Logic (.chm)

» zenon product documentation (.pdf)

Note: The tool is only available in English

3 License information

Part of the standard license of the Editor and Runtime.

5.1 Installation

The Documentation Download Tool is automatically installed with zenon.

5.2 Starting the program

To start the Documentation Download Tool:

» Gotothefolder C:\Program Files (x86)\Common Files\COPA-DATA\STARTUP.

» Start the program DokumentationDownloadTool.exe by double clicking on it.
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Online updating of the zenon Help:

Zzenon

» The program start dialog opens

Version: 7.00 SPQ - Path: C:\Program Files (x86)\COPA-DATA\zenon 7.00 SPONHELP
Version: 8,51 SPO - Path: C:\Program Files (x86)\COPA-DATA\zenon 6.51 SPOVHELP
Version: 7.10 SPQ - Path: C:\Program Files (x86)\COPA-DATA\zenon 7.10 SPOVHELP
Version: .21 SP1 - Path: C:\Program Files (x86)\COPA-DATA\zenOn 6.21 SPIVHELP

Version: 7.11 SPQ - Path: C:\Program Files (x86)\COPA-DATA\zenon 7.11 SPOVHELP

5.3 Navigation

It is possible to navigate through the individual dialogs by means of the navigation bar in the lower area
of the dialog:

Exit Closes the Documentation Download Tool
Back Goes back one dialog in the tool process.
Next

Goes forward one dialog in the tool process.

Proxy Settings Opens/closes expandable list for the configuration of the
proxy settings (on page 53).

Only active in the start dialog.




Online updating of the zenon Help:
Zenon

5.4 Proxy Settings

The proxy settings of your network can only be configured using the Proxy Settings entry.

To call this up, click on Proxy Settings in the start window of the tool. It is only possible to call this up in
the start dialog. This property is not active in subsequent dialogs.

Auto-detect proxy settings for this network The proxy settings of your system are used for
communication with the internet.

(Default: active)

Manual proxy configuration Enables the proxy settings to be configured.
Proxy: Address of the proxy server
Port: Port of the proxy server

(default: 8080)

User User name on the proxy server (optional)

Password: Password on the proxy server (optional)

Y Information

The Documentation Download Tool notes these proxy settings. If you regularly change
your password, you must also change the password in the proxy settings of the
Documentation Download Tool.

54.1 Incorrect proxy settings

An Internet connection could not be established. Please check your
proxy settings and try again.




Online updating of the zenon Help:
Zenon

An error dialog appears with incorrect entries.

Confirm this error dialog with ok to automatically return to input of the Proxy Settings.

5.5 Selection of version

In this dialog, select the version of zenon to be updated.

Version: 7.00 SPQ - Path: C:\Program Files (x86)\COPA-DATA\zenon 7.00 SPONHELP
Version: .51 SP0 - Path: C:\Program Files (x86)\COPA-DATA\zenon 651 SPOVHELP
Version: 7.10 SP0 - Path: C:\Program Files (x86)\COPA-DATA\zenon 7.10 SPOVHELP
Version: .21 SP1 - Path: C:\Program Files (x86)\COPA-DATA\zenOn 6.21 SPI\HELP
Version: 7.11 SP0 - Path: C:\Program Files (x86)\COPA-DATA\zenon 7.11 SPOVHELP

List of installed versions Lists the versions of zenon installed on the computer.
Select the version to be updated by simply clicking.
Note: only one version of COPA-DATA can be

updated each time. Multiple selection is not
possible.

Exit Closes the Documentation Download Tool

N . .
ext Goes forward one dialog in the tool process.

Proxy Settings Not active in this dialog.




5.6 Language dialog

Online updating of the zenon Help:

In this dialog, you select the zenon language to be updated.

m Zenon

List of available languages

Lists the languages available for zenon:
» English (ENGLISH)

» French (FRENCH)

» German (GERMAN)

» Italian (ITALIAN)

» Russian (RUSSIAN)

» Spanish (SPANISH)

Select the language to be updated by clicking on it.

Note: only one version of COPA-DATA can be
updated each time. Multiple selection is not
possible.

Zzenon

Exit Goes back one dialog in the tool process.
Back Goes back one dialog in the tool process.
Next

Goes forward one dialog in the tool process.

Proxy Settings

Not active in this dialog.




Online updating of the zenon Help:
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5.6.1  No updates available

If online and offline help is up to date, a dialog appears:

@ The selected language is up-to-date!

Clicking on the ok button reverts to the Language dialog.

5.6.2 Language-dependent content of zenon help

Available language content for zenon and zenon Logic:

English English English English
French French English English
German German German German
Italian Italian Italian English
Russian Russian English English
Spanish Spanish English English
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5.7 Overview of available updates

Once the update conditions have been selected, a dialog with the available updates is displayed:

Zenon

File Name: 3964R32.pdf - File Size: 1199912 Bytes
File Name: 35_32.pdf - File Size: 1272695 Bytes

File Name: 35_Arti.pdf - File Size: 1273118 Bytes

File Name: 35_Arti_NG.pdf - File Size: 1608156 Bytes
File Name: ALLAMNENT.pdf - File Size: 1291857 Bytes
File Name: APLCOM32.pdf - File Size: 1183233 Bytes
File Name: ARCNET_NT.pdf - File Size: 1212630 Bytes
File Name: AllenDFL.pdf - File Size: 1190684 Bytes
File Name: ArchDrv.pdf - File Size: 1261100 Bytes
File Name: BACnet32.pdf - File Size: 1446051 Bytes
File Name: BACnetNG.pdf - File Size: 2022434 Bytes
File Name: BUR20032.pdf - File Size: 1673534 Bytes
File Name: BURPVLpdf - File Size: 1746749 Bytes
File Name: Bachmann.pdf - File Size: 1219824 Bytes
File Name: BeckhBc32.pdf - File Size: 1182932 Bytes
File Name: BeckhNG.pdf - File Size: 14899591 Bytes
File Name: BeckhTc32.pdf - File Size: 1204370 Bytes

List of available Updates.

List of the documents that are available for the selected
version of zenon.

Note: the list is for information only. Selection is not
possible.

Exit Closes the Documentation Download Tool
Back Goes back one dialog in the tool process.
Next

Goes forward one dialog in the tool process.

Proxy Settings

Not active in this dialog.




Online updating of the zenon Help:

Zzenon

5.8 Status dialog

This dialog shows the progress when downloading the PDF and/or online help file to be updated.




Online updating of the zenon Help:

Zzenon

Fileinformation

Detailed information on the file that is currently being
downloaded:

» File origin
> File size

» Save location on the local computer

Current File:

Status of the current file including current download
speed

Overall Progress

Status of the complete update including percentage and
remainder display

Exit » Cancels the download that is currently in progress
» Closes the Documentation Download Tool

Pause Pauses the current download

Resume Resumes the download that was paused (by clicking on
Pause).
This button is only active if the Pause button has been
pressed beforehand

Cancel Cancels the current download

Proxy Setting Not active in this dialog.




Online updating of the zenon Help:
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5.8.1 Download complete

The following dialog is shown once the download has been completed:

Exit Closes the Documentation Download Tool
Resume Not active in this dialog.
Restart Reverts to the start dialog (on page 51) of the tool.

Proxy Settings Not active in this dialog.




Startup Tool
Zenon

5.8.2 Cancel

The following dialog is displayed once the Cancel button has been clicked:

Exit Closes the Documentation Download Tool
Resume Not active in this dialog.

Restart Reverts to the start dialog (on page 51) of the tool
Proxy Settings Not active in this dialog.

6. Startup Tool

The Startup Tool makes it possible:
» to start Editor and Runtime with certain parameters

» to run different zenon versions on one computer in parallel
(already installed zenon versions are automatically created in the Startup Tool)

» to administrate different SQL instances for the same zenon version
» to administrate the settings for different versions

» to define the language of the Editor and the Runtime before the start




» To define the language of the web client

3 License information

Part of the standard license of the Editor and Runtime.

A Attention

The Startup Tool does not start when the service zenAdminSrv is not running. If it is not
active, you can start it manually in the Windows Control Panel under
Administrative tools/Services.

6.1 Start dialog

You administrate the currently installed zenon versions in the start dialog. From version 7.10, you have
the possibility to choose whether to start Editor and Runtime as a 32-bit application or as a 64-bit
application.

If only a 32-bit version of zenon 7.10 was specified or an older version was detected, only one button is
shown for the Editor and Runtime respectively:

Startup Tool = =
Application  Item Help
Name Version BER
L Yzenon 7.11 7.11 5P 0 Build 8957 Editor

Runtime
w Runtime

Register

| \?\ Tools
# Move entry down Move entry up &
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Startup Tool
zenon

If both versions are specified, separate buttons for 32-bit and for 64-bit are displayed.

Application  Item  Help

Name

7.11 5P 0 Build 8357

; Move entry down | ? Move entry up




Button

List of zenon
versions.

Move entry down
Move entry up

Editor

Runtime

Register

Help

Tools

Function

Shows all installed zenon versions.

Moves the selected entry in the list downwards.
Moves the selected entry in the list upwards.
Starts the Editor of the selected zenon version

Two separate buttons are available for 64-bit versions. The button for 64-bit
contains a corresponding indication in the bottom left corner.

Starts the Runtime of the selected zenon version

Two separate buttons are available for 64-bit versions. The button for 64-bit
contains a corresponding indication in the bottom left corner.

Registers all services of the selected zenon version.
» Standard: Registers zenon. ZenSysSrv is registered as a process.

) Terminal Server: Registers zenon for use with a terminal server.
Procedures:
ZenDBSrv is deregistered and no longer re-registered and also not started.
ZenSysSrv is registered as a service.
The entries in zenon6. ini are amended for use on the terminal server.

If, in an entry, there are no parameters (on page 78) stored for workspace
and/or Runtime, the current version is re-registered. This applies for
registration as standard and as a terminal server.

Opens online help.

Opens a dialog for starting additional applications of the selected zenon version

If the tools for a valid 64-bit version are opened, then the tools are
displayed in two lists for 32-bit tools and 64-bit tools.

PROCESSES DURING STARTING

When starting the Editor or the Runtime, data from the start settings are written to the zenon6.ini
file. Existing settings in the INI file are overwritten.

Since version 5, network communication has been handled with the two services zenNetSrv.exe
and zenSysSrv.exe. Both files must exist in the zenon folder. As these services are version
dependent, they must be registered for the appropriate version.
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A Attention

After conversion of a project into a later zenon version, this can no longer be edited with
the previous version and will no longer run on it. However, the backup version created
during the conversion can still be used in the original editor.

For network projects, the same zenon Editor versions must be started on the server and
clients.

6.1.1  Application

Entry Function
Options Opens the dialog for configuring the settings.
Exit Closes the Startup Tool.
OPTIONS
4

The options entry in the application menu opens the dialog to configure the properties for:

» General (on page 66): general settings

» Network configuration (on page 67): Configuration of the network and the strong encryption of
network communication

» Listening ports (on page 70): Configuration of the listening ports

» Service startup: Start programs as a service
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Startup Tool
zenon

General

General settings:

General | Netwark configuration | Listening ports | Service startup|

[ start Startup Tool minimized

Remember last registered version
Register all OCX files of selected version
Unregister all OCX files of selected version

Language for Editor and Runtime
| English




Parameters

Start Startup Tool
mimimized

Remember last
registered version

Register all OCX files of
selected version

Set Language for Editor
or Runtime

Network configuration

active

Starts the Startup Tool minimized.
You can reach the tool with the help
of its icon in the task bar.

The context menu offers all possible
actions from the Start dialog (on page
62) for the active zenon.

Sets the chosen version as standard
and selects it automatically at the
next start. Then the version is not
registered again (default).

registers all OCX files (ActiveX
controls) which exist in the program
folder.

This option makes sure that there are
always appropriate ActiveX controls
for each version (default).

Attention: It has no influence on the
registration of ActiveX controls and
COM servers which are listed in the
individual settings (on page 84) of the
respective version.

Starts Editor or Runtime with the
language selected in the selection list.

Makes sure that zenon always uses
the defined language when started
from the Startup Tool. This does not
influence the direct start of
>CD_PRODUCTNAME<.exe.

The following applies for zenon from version 7 onwards:

» youcan use IPv6

» you can encrypt the transfer in the network.

This dialog configures:

» Time-outs

»  the use of TCP/IP via IPv4 or IPv6

inactive

Opens the tool on the desktop (default

Offers the first version in the list when
starting the Startup Tool. When the
Editor or the Runtime are started, the
respective version is always registered
again.

registers only the pre-set components.

This option accelerates the registration
process and is appropriate for all
projects which do not use ActiveX.

Starts Editor or Runtime with the
language defined in zenon6.ini. There
the set language is the language which

).

has lastly been used in zenon or defined

there under Options -> Settings ->
Editor and Runtime selected language
(default).
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Startup Tool

» the serious encryption of the network communication at the local computer

General | Network configuration | Listening ports | Service startup |

General settings

Metwork communication timeout

[ @l

Metwork module timeout
s

Time synchronisation with server project

[[Juse 1Pv6 for all TCR/IP connections (version 7.0 and higher).
ATTENTION: If you activate this setting you can no longer use
versions older than 7.0!

Encrypt network communication (version 7.0 and higher)
[ClEncrypt network communication

Password

Confirm password

Zzenon




Parameters

General settings

Network communication timeout

Network module timeout

Time synchronisation with server project

Use IPv6 for all TCP/IP connections

Encrypt network communication

Encrypt network communication

Description
General settings.

Changes of these settings are written to the registry in files
zenon6.ini or zenon. ini and overwrite possibly varying
manual configuration.

Changed settings must be carried out for all Runtime
computers or all connected stations. At changes of the IPv6
settings, the computer must be restarted.

Changes are carried out after leaving the dialog only
after the confirmation of a warning message with click
on button Yes.

Time-out for network communication in seconds.
Default =30

Equals entry NET_TIMEOUT_MSEC= in file zenon6. ini.

Time-out for module communication in seconds.
Default =30

Equals entry NET_NETMODULE_TIMEOUT_MSEC= in

file zenon6.ini.
Active: Time is compared with a server project (default).

Inactive: Timeis not compared (for circular redundancy,
for example)

Equals entry TIMESYNCH in file zenoné.ini.
Active: All TCP connections are only established via IPv6.

Inactive: All TCP connections are only established via IPv4.
Dual operation is not possible.

Equals entry USEIPV6= in file zenon6.ini.

Note: If this option is changed, the computer must be
rebooted. The change must also be carried out on all
connected stations.

The following components are not affected by the setting:
»  Driver communication with the PLCs
» Protocol communication in the Process Gateway plug-ins
»  Workbench and Runtime communication in zenon Logic

Attention: Only works with version 7 onwards. No versions
prior to version 7 can be started if this is active.

Settings for serious encryption in the network

Active: Communication in the network is encrypted.
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Note: This encryption is also applicable for zenon web client
communication.

Password Enter password.

For the criteria, see the "Network encryption password"
section in the Strong encryption of network communication
chapter.

The displayed length is always setat 20 characters,in
order to hide the actual length.

The password defined here is stored encrypted in the

zZenon6.ini.

Verify password Enter the password for verification again.

& Attention
If entries were changed manually in the local zenoné6. ini, they are overwritten as
soon as the confirmation message is answered with "ves" at the registration.
MESSAGES

For explanations about system messages and error messages see chapter Message at registration (on
page 86).
¥ Information

You can find notes on error messages from strong encryption in:

Network handbook -> Strong encryption of network communication chapter -> Error
messages section.

Listening ports

In this tab, the ports that are used by zenon can be individually configured for individual applications.
The settings that were saved in the respective zenon6. ini file are used in Runtime.

70



A Attention

Note the following during configuration:
» Changes in this tab can trigger a restart of the computer.
»  All computers with which communication takes place must have the same settings.
» These settings are not available under Windows CE.

» If an IP address is defined, it must be amended if the setting for IPv6 is activated or
deactivated

» If a defined network address is not connected at the time when the service is started, no
listening socket is opened

»  Error messages are not logged in the diagnosis server but in the Windows application
event log

LISTENING PORTS DIALOG

Application settings “
General | Network configuration | Listening ports | Service startup

Application Settings

L %1 A dministration Service
Q Analyzer Connector Service
Q Analyzer License Service

®) Al network adapters
J Single local IP address

0.0.0.0
3 DB Service Rt
g Loigmgksserw.ce () Single network adapter
etwork Service
3 SNMP Trap Service Ethernet
QTransport Service

£ WEEB Service Classic

£ WEB Service Tunneling (®) Default port
50777

() Customer port

50777




Parameters

Application

Settings

All network adapters

Single local IP address

Single network adapter

Default port

Customer port

OK

Cancel

PORT ASSIGNMENT

Description

List with all configurable applications. The selected application can
be configured by means of the options in Settings.

Settings for the application selected in Application.

All available network cards are used for the binding of the listening
ports. (as before). This is a standard setting.

The local address defined here is used for the binding of the listening
ports.

Supported protocols:
> IPv4
> IPv6

The first address of the network card defined here is used for the

binding of the listening ports.

The standard port number is used for the binding.

The port number defined here is used for the binding.

Applies all changes in all tabs and closes the dialog.

Discards all changes in all tabs and closes the dialog.
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Assignment of the standard ports to applications:

Administration Service 50777
Analyzer Connector Service 50778
Analyzer License Service 50779
DB Service 1103
Logging Service 50780
Network Service 1100
SNMP Trap Service 50782
Transport Service 1101
WEB Service Classic 1102
WEB Service Tunneling 8080

Service startup

Programs can be started automatically using the zenstartupMgr service. You can use this to start
Runtime automatically as a service.

DIALOG SERVICE STARTUP

| General | Network configuration | Listening ports | Service startup




Startup Tool
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Liste Services List of configured services.

New Opens dialog to select a program.

Edit Opens the dialog to edit the highlighted entry.
Delete Deletes the highlighted entry.

OK Applies all changes in all tabs and closes the dialog.
Cancel Discards all changes in all tabs and closes the dialog.

SELECT PROGRAM DIALOG

Program
| C:\Program Files (x36)\COPA-DATA\zenon 7,11 SP0\Zenrt32.exe|

Parameters

Program Path to the program that is to be started as a service. A click on the ... button
opens the file selection dialog.

Maximum length: 259 characters

Parameters Input of parameters.

Maximum length: 259 characters

OK Applies settings and closes the dialog.

Cancel Discards all changes and closes the dialog.

START RUNTIME AS A SERVICE

To start Runtime as a service:

1. Register the file zenstartupMgr.exe as a service:
Configure the properties for sign-in.
Start, if necessary, Remote Transport with zenstartupMgr

Define the Runtime to be started in the Startup Tool

vk W

Configure a start delay for zenon Runtime if you are using a dongle license

You can find details on this in the Runtime manual in the Starting Runtime as a service chapter.




Attention: If Runtime is started using the zenStartupMgr, it can no longer be stopped or restarted by
users.

REGISTER SERVICE

To register zenStartupMgr . exe as a service:
1. Openthe command line.

2. Go to the save location of the file zenstartupMgr . exe.

(default with 32-bit 0OS: $ProgramFiles (x86) $\Common
Files\COPA-DATA\zenStartupMgr

(default 64-bit OS: $ProgramFiles\Common Files\COPA-DATA\zenStartupMgr)

3. Register the file as a service with the zenstartupMgr.exe -service command.

Note: The service, if it is already running, is first stopped and then registered. If zenstartupMgr
is running, it is closed.

CONFIGURE SERVICE FOR THE USE OF MANY DRIVERS

Windows as an operating system limits the number of windows that can be created due to its fixed,
reserved desktop memory, depending on the version and possible integration with the desktop.

Version/action
Windows 7 32-Bit 12 MB 512 KB
Windows 7/Windows Server 2008 R2 64-bit 20 MB 768 KB

zenon drivers each need several windows. The number of drivers that can be used can be influenced
using the Allow data exchange between service and desktop option in the properties of the service.

» TInactive A maximum of 20 drivers can be started.

» Active: As many drivers as there are in a Runtime started as a user process can be started.
To activate the Allow data exchange between service and desktop option:

1. Open the Windows Service Manager.

2. Open the properties of the zenstartupMgr service.
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3. Gotothe Login tab.
zenStartupMgr Properties (Local Computer)
General | Log On RP| Console Root\Services (Local) i
Log on as:
(®) Local System accourt
Allow service to interact with desktop
() This account: Browse
Help me configure user account log on options.
Cancel
4. Activate the Allow data exchange between service and desktop.
This service must be configured to automatic start type. With the service active, the user
logged on to the computer is notified if the zenon Runtime as a service opens an additional
window, for example in the event of a new alarm and active status line.
Note Windows 8/Server 2012: In order for the service to be able to be started, the entry must
be set correctly in the Windows registry:
a) Gotothe entry
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Windows.
b) Open or create the DWORD value NolnteractiveServices.
c) Setthe decimal value of 1 to 0.
5. To stop Runtime messages being displayed on the desktop:
Deactivate the Detection of inactive services service.
6.1.2 ltem
The menu Item has the following entries:
Entry Function
New Creates a new entry in the list and opens dialog Properties (on page 77).
Delete Deletes the selected entry after confirming a confirmation message.
Properties Opens dialog Properties (on page 77) for the selected entry.
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6.1.3  Help

In menu help the following entries exist:
» Help: opens the online help

» Info about: shows current version information.

6.2 Properties

In dialog Properties the parameters for each entry are defined:

General General settings

Database Settings for the database connection

Extras Settings for registering ActiveX controls (OCX) and COM servers (DLL) and for starting
additional programs or batch files.




6.2.1 General

In this part, details about the zenon versions are entered. The path to the 32-bit version of zenon is

absolutely necessary. If the Startup Tool detects a 64-bit version, the path to the 64-bit version is also
unlocked for input.

.
Properties...

S

General | Datal |Exhas

General
MName

lzenon 7. 10|
Version

7.10 5P 0 Build 4582
Program path {32-bit)

C:'Program Files (x86)\COPA-DATA\zenon 7. 10 SPO E]
Program path (64-bit)

C:\Program Files\COPA-DATA\zenon 7.10 5P0 E]

Editor
Workspace
C:\Wsers\Public\Documentszenon_Projects\7100\710.w E]
Editor-Project
710 -

"] read back the INI settings

Runtime
RT-Project

710 -
RT-Path

C:Wsers\Public\Documentszenon_Projects| 7101710 E]

%

[ oK J [ Cancel

]

The following properties are available for a selected entry:
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GENERAL

Parameters

Name

Version

Programm path (32-bit)

Programm path (64-bit)

EDITOR

Parameters

Workspace

Editor-Project

Overwrite INI settings

Take over INI settings

RUNTIME

Parameters
RT-Project
RT-Path

Description

Distinct name as it should be displayed in the list. This entry is absolutely
essential.

Startup Tool automatically enters the version number of zenon. For this you
must first select the program path under Path.

Program path in which the executable 32-bit version of the zenon file
(Zenrt32.exe) is located.

If a 64-bit version of zenon is detected here, the Program path (64-bit)
property is also unlocked for input.

Program path in which the executable 64-bit version of the zenon file
(Zenrt32.exe) is located.

Input only possible if the path to the 32-bit version was stated and a 64-bit
version was detected by zenon.

As soon as both paths have been entered correctly, the buttons for starting
Editor and Runtime are divided into two buttons, one for 32-bit and one for
64-bit.

Description

The desired workspace when the Editor is started. As soon as this is entered
all projects which are in this workspace are displayed automatically in the
drop-down list under Editor project.

Select the project which should be active after the Editor started.

Active: The settings of this dialog are always used when the Editor is
started. Changes made while working with the Editor are discarded. (This
affects Workspace, Editor-Project, RT-Project and RT-Path).

Active: All amended settings for Workspace, Editor project, RT
project and RT path are saved in zenoné6. ini after the Editor is closed,
read into the Startup Tool and used again on the next restart.

Description
Project that is set as the start project for Runtime.

Path of the project. If the Runtime project is part of the workspace, the path
is entered automatically.
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UNKNOWN PARAMETERS?

If the settings for the workspace are unknown, use the following approach.
1. Enter Name, Path and Workspace
2. Leave Editor-Project, RT-Project and RT-Path empty
3. Activate Read back the INI settings
4. Leave dialog by clicking ox.

After the Editor has been started and closed once, the start settings are automatically
taken from the INI file.

6.2.2 Database

Define the database properties. It is possible to use different SQL instances for the different entries
(zenon versions).
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A Attention

As of version 6.51 the SQL instance can be defined and the password is saved in an
encrypted form. New entries have a higher priority than existing entries.

Compatibility: If nothing is changed, the existing entries remain valid. If you change an
entry for version 6.51 or higher, the new entries are valid. Older versions must be
maintained separately. You can find the settings for version previous to 6.51 in chapter
Database previous version 6.51 (on page 83).

Display dialog: The display of the dialog is automatically adopted to the selected
version (previous 6.51 (on page 83), as of 6.51).

Properties... @
General | Database | Extras

[ Read from zenDE.ini l ’ Clear all fields ]

SQL Instance

localhost\ZENON_2012 -
DE Path

C:\ProgramData\COPA-DATA\SQL2012Y
User

zenOnSry

Password

QK ] [ Cancel
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Entry

Read from zenDB.ini

Clear all fields

SQL Instance

DB Path

User

Password

Function

Clicking on the button reads off the settings from the zenDB. ini file and the
following fields are automatically filled:

» SQL instance

» DB Path
> User
» Password

All input field are cleared.
Empty entries are not written to zenDB.ini at registering.
Name of the SQL server instance which should be used.

The name can be entered directly in the input field or can be selected from the
drop-down list.

Note: By clicking on the drop-down list the local computer is searched for
instances which are then listed. The search may take some time.

Path for the SQL database of the zenon projects.
For example: C:\ProgramData\COPA-DATA\SQL\

Attention: Different SQL Servers (for example 2008R2 and 2012) must use
separate paths.

Background: When converting projects the GUID stays the same. If the same
folders are used, both instances overwrite each others database files.

User name for the database.

Necessary rights

In the SQL Server the user must have the following Server roles:
» public

» sysadmin

Password of the user. It is stored encrypted. The entry length is always displayed
with 20 characters regardless of the actual length.

Attention: The encryption is done via the Startup Tool. Therefore you must carry
out the database setting via the Startup Tool.

These settings are saved in the zenDB. ini file.
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Database previous version 6.51

Setting of the database property before zenon 6.51:

| Properties... &‘
General | Database | Extras
Read from zenDB.ini ]
| ( Clear all fields
Pravider: Provider =SQLNCLL. 1;Password=srv_501;Persist Sea
i DE Path: C:'\ProgramDataiCOPA-DATAISOLY
oK | Abbrechen
Entry Function
Read from zenDB.ini After a click on the button, the settings from file zenDB. ini are read and the fields
Provider, DB Path are filled automatically.
Clear all fields All input field are cleared.
Empty entries are not written to zenDB.ini at registering.
Provider Connection to the SQL instance. Important information:
» Instance name
» Used provider
» User name
» User password
For example:
Provider=SQLNCLI.1;
Password=srv_000;
Persist Security Info=False;
User ID=zenOnSrv;
Initial Catalog=%s;
Data Source=localhost\ZENON_DEV;
DB Path Path for the SQL database of the zenon projects.

For example: C:\ProgramData\COPA-DATA\SQL\

Attention: It is necessary that SQL Server 2005 and SQL Server 2008 R2 use different
folders.

Background: When converting projects the GUID stays the same. If the same folders
are used, both instances overwrite each others database files.
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A Attention

The entry for Provider differs in this dialog from the entry in the zenDB.ini.

Dialog: String starts with Provider=. ..

zenDB. ini: String starts with Provider=Provider=. . .

6.2.3 Extras

Here, you create ActiveX controls (*.ocx) or COM servers (*.dll) which should be registered together
with the respective zenon version. The OCX and DLL can originate from any source, i.e. they can be

written by you or by other manufacturers. Additionally you can define programs which are carried out

before the starting or after the closing the Editor or the Runtime.

Fovertes. . 0
General | Database | Extras

Register ocxfdll files

Filename

Filepath

Add

Remave

Execute

Pre Start: |

Past Start:

(o]
(o]

Ok ] [ Cancel

]

REGISTRATION ACTIVEX CONTROLS - COM SERVER

All files listed here are automatically registered together with the respective zenon version -
independent of the central setting (on page 62) register.
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Filename/Filepath List of all files to be registered

Add opens the Windows dialog for selecting a file to be registered. There you can
select OCX or DLL files individually and add them to the list. First select the
wanted file type (OCX or DLL).

All files are saved with path information. If the path changes, remove the link
with Remove and create a new one.

Remove Removes all selected entries from the selection list of the files to be
registered.

PRE-START AND POST-START PROGRAMS

With Pre Start and Post Start, you can define programs and batch files which should be executed before
starting or after closing zenon.

Pre Start External program that should be started, before the Editor or Runtime is
started.

Post Start External program that should be started, after the Editor or Runtime is
closed.

Attention: Post Start is only executed if the Read back the INI settings
(Item->Properties->General) option was activated.




6.3 Message at registering

POP-UP AT REGISTERING

Message

You have changed the IPv6é setting. All
internal TCP/IP connections will be
switched to IPv6/IPv4.

To ensure that all affected components are
properly switched you have to restart the
computer! You will also have to change this
setting on all connected station!

Do you really want to apply the change?

Gerneral network configuration settings
will be changed.

You have to restart the runtime to apply the
changes!

Attention: Do not forget to adept the
settings on other stations as well.

Apply settings.

Are you sure this is your intent?

MESSAGE AT REGISTERING

Meaning

You change the settings for the IP protocol from
IPv4 to IPv6 or vice versa.

After the changes you must restart the computer for
all services to be adapted accordingly. The change
must also be carried out on all connected stations.

These changes are written to zenon6.ini or
zenon. ini together with the registration and
overwrite any manual configurations.

You change general settings (on page 67) in the
same ways as time outs.

These changes are written to zenon6. ini or
zenon. ini together with the registration and
overwrite any manual configurations.

You must adapted changed settings for all Runtimes.

At registering the service all steps are displayed in an own window which closes after 4 seconds
automatically. When an error occurs, an warning message informs you about the cause. After
confirming the message the procedure is canceled. zenon is not started. Possible error messages:
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Message

Couldn’t find
zenNetSrv
Service!

zenNetSrv.exe
still running!

Couldn’t find
zenSysSrv
Service!

zenSysSrv.exe
still running!

6.4

Reason

File zenNetSrv.exe is missing from the
zenon program folder or a wrong version is
available.

The service zenNetSrv.exe could not be
stopped.

File zenNetSrv.exe is missing from the
zenon program folder or a wrong version is
available.

The service zenSysSrv.exe could not be
stopped.

Command line

Hint

Most of the time the fastest an safest
solution is a new installation of
zenon.

It is possible that a security tool is
running on the computer which
prevents the access.

Most of the time the fastest an safest
solution is a new installation of
zenon.

It is possible that a security tool is
running on the computer which
prevents the access.

You can also operate the Startup Tool using the command line. For this file zenon_Startup.exe must be
present in the system path. You can find the file

» for Windows 7/8 inthe C:\Program Files\Common Files\COPA-DATA\STARTUP

folder

In the commando line you can:

» create new entries (on page 88)

» reorganize (on page 91) existing entries (e.g. after older versions have been deleted)

» register (on page 91) entries

6.4.1

Parameters

The input is started with zenon_startup.exe followed by a Parameter and possible field names.

Parameters:
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Parameter Function Field name
S

-new creates a new entry. yes, list see also new (on
page 88)

-reg registers services Name of the entry

-reorg checks and reorganizes existing entries not available

Return value

Oorl

none

none

If the startup tool is only called up with -reg, only the version is re-registered. In doing so, zenoné6.ini
is accessed on a read-only basis only. The version defined in the [PATH] section is registered; all

parameters are taken from zenon6. ini.

USING SEVERAL PARAMETERS AT ONCE:

It is possible to use several parameters at once. If several -new parameters are used at once, the return

value cannot be evaluated unambiguously.

In general when several parameters are used, it is proceeded in the following order:
1. -new: Create new entries.
2. -regq: Register the stated entry.

3. -reorg: Remove all invalid entries for deleted zenon versions.

new - Creating new entries

Parameter -new is used for creating new entries. It needs at least two field names:
» NAME as unique name for the entry
If the name of the entry is already available, no entry is created.

» PATH as path in which zenon is stored.

SYNTAX

The syntax is constructed as follows: zenon_Startup.exe -> Parameter > Field name="TEXT"

zenon_Startup.exe
Space

Parameters

Space

Field name

= character

N o u s~ W N oRe

opening quotation marks
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8. Text

9. closing quotation marks

el Example

zenon_Startup.exe -new NAME="New entry" PATH="C:\Example Directory\zenon"

FIELD NAME

The following field names can be used:
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Field name

NAME

PATH

PATH64

PROJECT RT

PROJECT_RT_PATH

PROJECT_ED

WSP

SQLSRV

PROVIDER

DBPATH

PRESTART

POSTSTART

Mandator
y field

X

Description

Unique name of the entry.
For example: NAME="Test"
The user path in which zenon is saved.

For example: PATH="C:\Program Files
(x86) \COPA-DATA\zenon 7.10 SPO"

The application path, in which the 64-bit version of zenon is located.

For example: PATH="C:\Program Files\COPA-DATA\zenon 7.10
SPO"

Name of the Runtime project which should be started.
For example: PROJECT_RT="Test project"
The Runtime folder of the project (see PROJECT_RT).

For example:
PROJECT_RT_PATH="C:\Users\Public\Documents\zenon p
rojects\test projekt"

The project which should be activated in the Editor.
For example: PROJECT_ED="Test project"
The workspace with which the Editor should be loaded.

For example:
WSP="C:\Users\Public\Documents\zenon projects\DE
MO622 .WSP6"

Name of the SQL Server which should be used by the Editor.
For example: SQLSRV="MSSQLSZENON_DEV"
Provider string for the initialization of the SQL connection.

For example:

PROVIDER="Provider=SQLNCLI.1; Password=000; Persist
Security Info=False;User ID=zenOnSrv;Initial
Catalog=%s;Data Source=localhost\ZENON DEV;"

Path for the SQL database which should be used
For example: DBPATH="C: \ProgramData\COPA-DATA\SQL\"

Program call which is executed before the start of the Editor or the
Runtime or the registering of this version.

For example: PRESTART="C:\zenon versions\zenon
6.50\DlIs\zenVNCCli.exe"

Program call which is executed after the Editor is closed.

For example: POSTSTART="C:\zenon versions\zenon
6.50\DlIs\zenVNCCli.exe"
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Attention: Post Start is only executed when in the Startup Tool or in
Startup.ini option Read back the INI settings (Item -> Properties ->
General) is activated.

The field names are separated by spaces.

¥ Information

Paths with spaces must always be put between parentheses.

RETURN VALUES

0 - execution faultless

1 - entry could not be created

reorg - reorganizing of entries

Parameter -reorg checks all entries whether the linked zenon version is still available in the file system.
If the application files are no longer found, the entry is finally deleted from the Startup Tool.

The command does not provide a return value. After execution the Startup Tool is started.

Example: zenon Startup.exe -reorg

reg - register entries

The -reg parameter registers all necessary services in the folder of the stated entry. It is called up via:

» -reg"Name of the entry"

If the Startup Tool has already been started, nothing is registered but the Startup Tool is moved to the
foreground.

The command does not provide a return value.

#  Example

zenon_Startup.exe -reg "Version 6.50"

registers version 6.50.

Prerequisite: there is an entry with this name in the Startup Tool.
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7. System Information Collector

When solving problems, COPA-DATA Support may ask for the relevant data about your operating system
and zenon. The easiest way for you to create this data is in an automated manner with the System
Information Collector and then sending this to Support.

7.1 Starting the System Information Collector

The system Information Collector is also installed when zenon is installed. It is located at:

» Computer in the path: $Program Files (x86)%\Common
Files\COPA-DATA\STARTUP

» Installation medium in the path \Additional Software\System Information
Collector.

To start the Ssystem Information Collector:

1. Windows 8: enter sIc as a search term for apps on the desktop
Windows 7: go to Start/All Programs/zenon/Version Independent Tools
or: start it from the installation medium

2. Click on system Information Collector

92



3. The System Information Collector starts

= S e (e e - olEN|

Full

'x._.(_‘ Collect all system and Scada related information.
Full
System
éi Collect only system related information.
System
Scada
5 Collect only Scada related information (do not include dump files).
Scada

Scada with dumpfiles
! Collect only Scada related information (include dump files).

Scada

MENU AND TOOL BAR

MENU

The following options are available to you in the menu:

» File
e New Scan: Opens the Start window.
e Open: opens a saved report
e save: saves the currently-displayed report as a ZIP file
e Exit: closesthe system Information Collector
» Edit
e copy: copies highlighted text to the clipboard

e Find: opens a dialog to search the current report

>  View

e  Expand: expands all nodes
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e Collapse: closes all nodes
> Help

e About: Information on the program version

With the exception of Exit and About, all options are available via the tool bar.

TOOLBAR

Lyl Es B

Symbol Description

Home New Scan | Qpens the Start window.

Open Opens a saved report.

Save Saves the currently-displayed report as a ZIP file.
Copy Copies highlighted text to the clipboard.

Find Opens a dialog to search the current report
Expand Expands all nodes.

Collapse Closes all nodes.

7.2 Collecting information

To collect information in an automated manner:
1. Start (on page 92) the system Information Collector
2. Select one of the four options by clicking on the corresponding button
e Full: collects information about the system and zenon. Dump files are not collected
e system: collects information about the system only

e Scada: collects information about zenon, without dump files



e Scada with dumpfiles: collects information about zenon and includes dump files

= System Information Collector - olEN|

i File Edit \

Full
'
\‘.-;.6 Collect all system and Scada related information.
Full
System
\gi Collect only system related information.
System
Scada

Collect only $cada related information (do not include dump files).

i

Scada with dumpfiles
Collect only Scada related information (include dump files).

A |
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3.

The system Information Collector creates a report with the desired information

i File

Edit  View

System Information Collector - olEN|

System Info
Processes

CemExec.exe
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4. The completed report is displayed in the main window

- Systemn Info
G-fal Console
#-(5l Files

- Registry
{5 Scada

System Information Collector - olEN|

~
ull ll
Name Full
Description Collect all system and Scada related information
Time (UTC) 20131115 08:28:00,326
Created with SIC version 7.11, Build 8086
Registered SCADA version C:\Program Files (xB6\COPA-DATAzenon 7.20 SPO
Summary
Projects
V scheme files for version 7110 Complete.
A - S .
A AN Scheme files for version 7200 ConvertTo_601.5ql is missing.
saL
v nnecting SOL-SERVER [SQL2012] Connection to ATSZG-WKS04BZENON_2012 established.
e Ce ng Mo connection available
i’!} Login failed The sql user zenOnSn does NOT exist
Zenon
W Signature for Tenone32 e’ s valid, version: 7110, 32bit
V Systemn Signature for ‘zenrt32 exe’ is valid, version: 7110, 32bit
Qy Signature for Tenon32.diIF is valid, version: 7110, 320iL
& M

ystem Signature for ‘zenone32 exe' is valid, version: 7110, 84bit

7.3 Using the information

All information collected is displayed in the System Information Collector. They can:

» Save the report

» Navigate through the report and search for certain information
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» Highlight selected information and copy it to the clipboard

= System Information Collector - olEN|

&3 Full

+-{Ea System Info ~
@) {5 Conscle StartUp.ini nitializationFile
-3 Files
= (& Registry .
I o
-1 Scada Name StartUp.ini
a-[d saL Path C:\ProgramData\COPA-DATAISysterm)
w1 versions
= CD_System & mttached ves
) KSLICENSE.INI
=) straton_cfg.ini FILE vFO
- = zenAnalyzer.ini File name C\ProgramData\COPA-DATASystem\StartUp.ini
J zenDB.ni FILE_ATTRIBUTE_ARCHIVE
= ) I ILE_ATTRIBUTE_ARCHIV
= zenonbini Filo siibutes FILE_ATTRIBUTE_NOT_CONTENT_INDEXED
| zenProcGateway.ini
Y| zenWebSrv.ini File size 31
Creation time 2013/07/01 12:02:37,385
Last access time 2013/07/01 12:02:37,385
Last write ime 20131114 14:01:51,146
CONTENT
[DEFALILT]
COUNT 2
REGISTERED 1
SELECT 1
[ITEMO]

[ & DBPATH e

SAVING A REPORT

To save a report:

1. Click on the save symbol or the save command in the File menu

2. The dialog for voluntary entry of a password for the encryption of a report opens
3. the dialog for selecting a folder and file name is opened
4

The report is saved as a ZIP file

OPEN REPORT

To open a saved report:
1. Click on the Folder symbolin the tool bar
2. Select the report

3. If you have entered a password for the encryption of the report when saving, enter it again now
or jump the step by clicking on ok

4. The report is opened
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SAVING SELECTED INFORMATION

To saved selected information only:
1. highlight the relevant information.
2. Click on the copy symbol or the copy command in the Edit menu
3. The selection is saved to the clipboard
4. Insert the content into a text file and save this
5

Repeat this process for further selected information

7.4 Forward report to COPA-DATA

The report can, depending on its size, be forwarded as an e--mail or uploaded to a defined save location
to COPA-DATA. You can find out details on how you forward the report and which online save location
you can use for this from your COPA-DATA Support contact.
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